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La interfaz de Blender 
En este primer tutorial nos dedicaremos a familiarizarnos con la interfaz de usuario de Blender. 

Blender es un potente programa de creación, renderizado y animación de gráficos 
tridimensionales, de código abierto. 

El uso de este tipo de programas es, a priori, de los más difíciles entre las diversas 
herramientas de creación multimedia. Trabajar un mundo tridimensional en una pantalla 
bidimensional, desplazando un ratón sobre una mesa, de nuevo, en dos dimensiones, exige un 
esfuerzo de abstracción considerable. 

Es por ello que en los primeros pasos de esta guía nos dedicaremos, sencillamente, a pasear 
por la interfaz del programa, y todo aquello que creemos no pasará del mero bodegón, en un 
intento de adquirir soltura en el manejo de Blender. 

Como se verá, la interfaz de Blender no sigue las directivas de los programas Windows, por lo 
que resulta fácil desorientarse al principio. Sin embargo, una vez pasadas las primeras horas, 
comprobaréis como os desenvolvéis con comodidad por el programa, consiguiendo buenos 
resultados de manera sencilla y eficaz. 

Primeros pasos con Blender  

 
Esta es la pantalla inicial de Blender. El principio no es alentador. La parte inferior está llena de 
botones de diferentes tamaños y colores. En la ventana gráfica aparecen dos símbolos: un 
cuadrado rosa y una especie de  triángulo. 

El cuadrado es un cubo que coloca por defecto Blender en las escenas. El color rosa indica 
que el plano está seleccionado. La figura que hay algo más abajo, a la derecha, es la 
cámara. Las líneas negras forman la cuadrícula o rejilla (grid). Se usan como referencia y 
para aportar precisión. Finalmente, hay un círculo amarillo, un punto de luz que ilumina la 
escena. 

El círculo de color rojo y blanco situado en el centro del plano es el puntero 3D. Sirve para 
determinar dónde situaremos nuestros objetos en escena. Con el Botón Izquierdo del Ratón 
(en adelante, BIR) podemos cambiar su posición. Basta con llevar el ratón a cualquier posición 
de la ventana 3D y pulsar BIR. 

Y antes de ver nada más, probablemente la combinación de teclas más importante de Blender: 
Ctrl+X, que devuelve el programa a su estado inicial. 
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En pantalla tenemos una vista ortogonal: los rayos de proyección son perpendiculares a la 
ventana 3D y, por tanto, podemos ver los objetos dispuestos de manera paralela a la ventana 
3D en su verdadera magnitud. Las proyecciones ortogonales son útiles para trabajar con 
precisión. 
La vista activada corresponde a una vista de planta. El punto de vista es desde arriba. Vamos a 
cambiar a una vista frontal. Esto es, con el punto de vista de frente. Para ello, con el ratón 
sobre la vista tridimensional, hay que pulsar en el teclado numérico el 1 (en adelante, nos 
referiremos a esta tecla como KP1). 

 
Como ya se ha dicho, en las vistas ortogonales se saben con precisión las distancias y 
tamaños de todos los objetos. 

Si ahora se pulsa KP5, se activa el modo perspectiva (una nueva pulsación de KP5 nos 
devuelve a la vista ortogonal). 
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Finalmente, para mover el punto de vista, puede hacerse Alt+BIR y desplazar el ratón o, en un 
ratón de tres botones, hacer BCR (clic en el botón central) y desplazar el ratón. 

 
En el modo perspectiva se intenta representar la imagen como si fuera vista por el ojo humano. 
Es un modo de visualización, más que de trabajo. En este modo, las líneas de la cuadrícula no 
son paralelas: si las prolongáramos se encontrarían en un punto que se conoce como punto 
de fuga. Todas las vistas pueden funcionar tanto en modo perspectiva como en ortográfico 

Para volver al modo ortográfico y a la vista superior basta con pulsar KP5 y KP7. 

En todo momento tenemos disponible un recordatorio de todas las vistas posibles (y las teclas 
que las activan) en el menú View. 
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Aparte de las vistas predeterminadas, se puede aproximar o alejar el punto de vista (acción 
zoom) o hacer un desplazamiento lateral (acción pan). En seguida veremos cómo. 

Ya se ha visto que al hacer Alt+BIR y arrastrar el ratón, se modifica el ángulo de visión de la 
ventana 3D. Otra posibilidad, en un ratón de tres botones, es hacer clic con el botón central y 
arrastrar. 

 
Para conseguir el efecto zoom basta hacer Ctrl+Alt+BIR y arrastrar el ratón, hacia arriba si 
desea acercarse a la imagen y hacia abajo si se desea alejarse. En un ratón de tres botones 
con rueda en el botón central, también se puede utilizar esta para hacer zoom. 



Graduado en Multimedia (UOC)  Introducción a Blender 

Página  6

 
Para conseguir el efecto de pan, esto es, un desplazamiento lateral, hay que hacer 
May+Alt+BIR y arrastrar el ratón en la dirección que se quiere desplazar la vista. 

Redefinir ventanas 
Blender permite configurar las dimensiones de las ventanas, así como crear nuevas. 

La ventana superior que Blender muestra por defecto se denomina ventana 3D, mientras que 
la inferior se llama ventana de display buttons, en terminología Blender. 

Al situar el cursor sobre la barra frontera entre las dos ventanas el cursor adquiere la forma de 
flecha de dos direcciones. En ese estado, al hacer BIR y arrastrar el ratón cambian las 
dimensiones de ambas ventanas. 

El siguiente paso es dividir y unir ventanas (split areas/join areas). Hay que situar de nuevo 
sobre la barra que separa las ventanas y hacer BDR (esto es, click en el Botón Derecho del 
Ratón).Aparece el siguiente menú contextual: 

 
Split Area divide en dos el área seleccionada (que se distingue porque aparece en un gris más 
iluminado; en el caso de la captura de pantalla que se muestra aquí, se dividiría la ventana 3D). 
Al seleccionar Split Area aparece una línea delgada que se mueve siguiendo el cursor. Para 
seguir con el ejemplo, se lleva la línea divisoria hacia el centro de la pantalla y se hace de 
nuevo BIR para dividir la ventana 3D. 
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Un último paso, si andamos justos de espacio en pantalla, puede ser eliminar la cabecera que 
aparece en la parte inferior de cada ventana. Para ello, basta hacer BDR sobre la cabecera y 
seleccionar No Header. Una vista tradicional para los programas de creación 3D es la que se 
puede apreciar en el próximo paso: 

 
Como primer ejercicio sencillo se propone llegar a esta disposición en pantalla. 
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Tipos de ventanas 
Al iniciar el programa, la vista por defecto nos muestra la vista 3D en la ventana superior y la 
ventana de botones en la inferior. Se puede seleccionar la ventana que nos muestra Blender en 
cada espacio mediante el botón 'tipo de ventana'. 

 
En la ventana de botones (Buttons Window) se pueden seleccionar diferentes botoneras: 

 
• Lógica 

• Script 

• Sombreado 

• Objeto 

• Edición 

• Escena 

 Dentro de 'sombreado' se nos ofrecen 5 opciones:  

• Lámparas 

• Materiales 

• Texturas 

• Radiosidad 

• Mundo 

 Dentro de 'escena' se ofrecen 3 opciones: 

• Render (vista por defecto) 

• Animación y reproducción 

• Bloque de sonido 
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Cada uno de los paneles de las diferentes botoneras puede minimizarse usando el triángulo 
blanco que hay junto al nombre del panel. Además, los paneles pueden disponerse de manera 
libre (podremos desplazar los botones como deseemos), horizontal (es decir, un panel al lado 
del otro) o vertical (uno sobre el otro, disposición adecuada para ventanas de aspecto vertical). 
Para seleccionar la disposición basta hacer BDR en cualquier lugar de la botonera. 

 
En caso que necesitemos trabajar con comodidad con una ventana, podemos hacer que pase 
a ocupar toda la pantalla mediante la combinación de teclas Ctrl+CursorAbajo (pulsaremos 
Ctrl+CursorArriba para volver al estado inicial). 

 
En la ventana 3D podremos seleccionar el tipo de sombreado utilizado para la escena con el 
botón correspondiente. 

Las opciones son, textura, sobreado, sólido, alambre o caja. Las corresponientes teclas de 
acceso rápido son Z, Shift+Z, Ctrl+Z, Alt+Z. 

Resumen 
Nomenclatura 

• BIR: click en el Botón Izquierdo del ratón 

• BDR: click en el Botón derecho del ratón 

• KP1, KP2...: teclas 1, 2... del teclado numérico 

Vistas 

• KP1: Vista frontal 

• KP3: Vista lateral 

• KP7: Vista superior 

• KP5: Modos Perspectiva / Ortográfico 

Desplazamientos 

• BIR: Sitúa el cursor 

• Alt+BIR+Arrastrar: Cambia el punto de vista 

• Ctrl+Alt+BIR+Arrastrar: Zoom 

• Shift+Alt+BIR+Arrastrar: Pan 

Otros 

• Ctrl+X: Empezar de cero 



Transformaciones básicas 
En esta sesión se verán las transformaciones básicas: selección, movimiento, rotación y 
escalado de objetos. 

Estas son las transformaciones que nos permiten, a partir de un conjunto limitado de objetos 
básicos, construir un mundo complejo. 

Se trata de operaciones que se repetirán por docenas cada vez que se realice un modelo, por 
lo que es de vital importancia dominarlas para poder usar el programa de manera eficiente. 

La selección 
Si Blender no está en su estado inicial, se reiniciará (pulsando Ctrl+X). 

Como ya se dijo en la primera sesión, en la situación inicial el cubo aparece de color rosa, que 
quiere decir que está seleccionado. Por tanto, se le pueden aplicar diferentes acciones, como 
moverlo o rotarlo. 

 
¿Qué hay que hacer para seleccionar otro objeto (la cámara, por ejemplo)? 

Hay que situar el cursor sobre el objeto a seleccionar y hacer BDR. Al seleccionar la cámara, 
se obtiene la imagen de la izquierda. 

La cámara está seleccionada (y por tanto de color rosa) y el cubo no (y por tanto de color 
negro).  

Si se hace BDR de nuevo sobre el cubo se vuelve a la posición inicial, con el cubo 
seleccionado (y por tanto de color rosa) y la cámara no (y por tanto de color negro). 

Desplazar un objeto 
Con la cámara seleccionada de nuevo, para desplazarla por la vista de planta, se pulsa la tecla 
G (inicial de grab), con lo que tomará color blanco. Al arrastrar el ratón, el objeto seleccionado 
sigue al cursor. 
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Para soltar el objeto, hay que hacer BIR. 

Si se quiere cancelar la acción, hay que pulsar BDR o ESC. 

Es aconsejable, antes de iniciar una acción, que el cursor esté cerca del objeto seleccionado. Y 
hay que tener en cuenta que el movimiento que podemos realizar queda determinado por la 
vista que tengamos en pantalla. Probad a desplazar la cámara en cada una de las vistas 
posibles. 

Rotar un objeto 
Siempre con la cámara seleccionada, se pulsa la tecla R (rotate) para rotarla en la dirección 
deseada. De nuevo, la rotación dependerá de la vista seleccionada. Probad a rotar la cámara 
en cada una de las vistas posibles. 

 
Veamos ahora una vista nueva: la vista de cámara se activa con KP0. Así, si tenemos un punto 
de vista como la actual, obtendremos una vista como la siguiente: 
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Escalado de objetos 

En la vista que tenemos seleccionada, seleccionamos el cubo que hay en pantalla (con BDR), 
pulsamos la tecla S (de Scale) y, desplazando el ratón le cambiaremos el tamaño. 

Sin activar nada más, cambiamos el tamaño del objeto de manera uniforme: tanto su anchura 
como su altura y su profundidad. Con frecuencia querremos que una operación se limite a un 
solo eje. 

Para lograrlo podemos actuar de varias formas. 

La primera es restringir la acción a un solo eje con la tecla Alt. Por ejemplo, seleccionamos 
un objeto (G), pulsamos Alt+BIR y desplazamos el ratón horizontalmente. En pantalla 
aparecerá una guía en color verde, y sólo se desplazará el objeto a lo largo de la guía. Para 
finalizar la acción pulsamos de nuevo BIR. Lo mismo pasará si el primer movimiento que 
hacemos es en vertical. 

Una segunda forma, más eficiente, es, tras seleccionar la acción pulsar X, Y o Z, en función del 
eje al que queramos restringir la acción. Y una tercera forma, si se desea, es hacer BCR 

Especificar con exactitud desplazamientos, rotaciones y escalados 
Existen dos modificadores a la hora de hacer transformaciones con el ratón. La tecla May hace 
que el movimiento sea más preciso, mientras que la tecla Ctrl realiza una modificación del tipo 
'snap to grid', o 'ajustarse a la rejilla'. Probad ambos modificadores con desplazamientos (G), 
rotaciones (R) y escalados (S). 

Una segunda posibilidad, más precisa, es la de entrar numéricamente las magnitudes a operar. 
Para ello, una vez seleccionado el objeto que deseemos, pulsamos la tecla N, con lo que 
obtenemos la siguiente ventana: 
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En esta ventana podemos especificar exactamente las unidades en las que deseamos 
desplazar (Loc), rotar (Rot) o escalar (Size) el objeto con respecto a cada uno de los tres ejes 
(X, Y, Z).  

Para modificar cada una las celdas podemos hacer dos cosas: 

• pulsar BIR en la celda y arrastrar el ratón; 

• pulsar May+BIR sobre la celda, con lo que aparecerá un cursor y podremos introducir 
la magnitud exacta. 

El centro de rotación 
Al hacer una rotación es imprescindible especificar alrededor de qué punto se va a hacer la 
rotación. A ese punto le llamamos centro. 

Para especificarlo se utiliza el menú que tenéis en la imagen. Veamos cuáles son las cuatro 
opciones disponibles: 

 
• Individual Object Centers: En caso que tengamos más de un objeto seleccionado, 

cada cual girará alrededor de su propio centro. 

• 3D Cursor: La rotación se producirá alrededor del cursor. 

• Median Point: La rotación se producirá alrededor del centro de gravedad de los 
objetos seleccionados. 

• Bounding Box Center: Blender calculará la menor caja posible que contiene a los 
objetos seleccionados, y los hará girar alrededor de dicha caja. 

Modo de edición: Objetos y vértices 
Hasta ahora hemos accedido a los objetos como un todo. También necesitaremos acceder a 
cada uno de los vértices del objeto. Para poderlo hacer pulsaremos la tecla TAB. Si tenemos 
un objeto seleccionado (y por tanto de color rosa) y pulsamos TAB quedarán en rosa sólo sus 
vértices: 
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Pulsando TAB de nuevo volveríamos a seleccionar todo el objeto pero, de momento, 
dejémoslo con los vértices seleccionados. 

En modo de edición de vértices, el color rosa no indica que los vértices estén seleccionados. 
Para seleccionar todos los vértices, pulsamos la tecla A. Los vértices quedan seleccionados y 
resaltados en amarillo. 

Para seleccionar un solo vértice, debemos pulsar BDR sobre el vértice deseado. 

 
Si queremos seleccionar más de un vértice, seleccionamos el primero (BDR), pulsamos la tecla 
May y vamos haciendo BDR en los demás vértices que queramos seleccionar. 

Finalmente, si deseamos seleccionar todos los vértices dentro de una zona rectangular, 
pulsamos B, con lo que activamos la selección rectangular. Pulsamos BIR en un extremo del 
área deseada, y con el botón apretado, soltamos en el extremo opuesto. Se seleccionarán los 
vértices dentro del rectángulo seleccionado.



Añadir objetos 
En este módulo aprenderemos, finalmente, a añadir nuevos objetos a una escena. 

Comenzaremos añadiendo objetos de tipo 'malla poligonal', con los que podremos construir 
modelos complejos. Veremos las diferentes mallas que ofrece Blender, y las características 
particulares de cada una. 

A partir de ese momento veremos las diferentes acciones que podemos ejecutar sobre las 
mallas poligonales, como la agrupación, duplicación, operaciones booleanas o el tracking. 

Finalmente, veremos cómo añadir texto a la escena. 

Añadir objetos 
Para comenzar esta sesión, vamos a eliminar el cubo que tenemos en pantalla, y después 
añadir diversos tipos de objetos a la escena. Basta con seleccionar el cubo y pulsar la tecla 
Supr. Aparecerá un mensaje de confirmación, y haremos clic en 'Erase Selected'. 

 
Con la tecla ESPACIO accedemos a la Caja de herramientas, que aparece de dos manera 
diferentes, dependiendo de si estamos en el modo de edición de puntos o objetos: 
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Por defecto, la caja de herramientas se activa con la opción Add (Añadir), desde la que 
podemos añadir a nuestra escena todo tipo de objetos. Nos aseguramos de estar en modo de 
edición de objetos, y en primer lugar nos centraremos en la opción Mesh (malla poligonal), que 
dispone de las subopciones: 

 
• Plano 

• Cubo 

• Círculo (con un número seleccionable de puntos) 

• UV Esfera (con un número seleccionable de segmentos y anillos) 

• Icosfera (con un número variable de subdivisiones) 

• Cilindro (con un número variable de vértices) 

• Tubo (con un número variable de vértices) 
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• Cono (con un número variable de vértices) 

• Parrilla (con resoluciones variables para los ejes X e Y) 

• Mono (crea una imagen que se asocia con la ‘mascota’ de Blender) 

Al seleccionar la UVesfera (UVSphere) nos aparecen dos cuadros de diálogo consecutivos que 
nos piden el número de segmentos y el de anillos con que queremos construir la esfera. 

 

 
Para movernos en el cuadro de diálogo, podemos hacer BIR y arrastrar el ratón a derecha e 
izquierda o bien utilizar las dos flechas que hay a cada lado. Una tercera opción, más exacta, 
es usar el teclado, haciendo previamente May+BIR sobre el cuadro. 

 
La esfera aparece en modo edición de vértices, con todos ellos seleccionados. Recuerda que 
pulsando TAB saltamos del modo de edición de vértices al de edición de objeto. 

 

Agrupar objetos 

 
Con frecuencia nos interesará trabajar con diversos objetos como si se tratara de uno. Para 
agrupar tantos objetos como se desee debemos, en primer lugar, pensar cuál queremos que 
sea el objeto padre o principal. 

Una vez hecho esto, seleccionamos todos los objetos a unir, y hacemos que esté activo el 
objeto padre. Pulsamos May+G y aceptamos el cuadro de diálogo que aparece. A partir de 
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ahora todas las acciones afectarán por igual a todo el grupo. La relación se rompe pulsando 
Alt+P. 

 
Si pulsamos May+G accederemos a un menú desde el que podremos: 

 
• Children: Selecciona un objeto junto con todos sus descendientes (sus hijos, los hijos 

de sus hijos, etc.) 

• Immediate Children: Sólo selecciona los hijos directos del objeto activo 

• Parent: Selecciona el padre del objeto activo 

• Objects on Shared Layers: Selecciona los objetos que se encuentran en la misma 
capa que el objeto activo 

Duplicar un objeto 

 
Si tenemos un objeto seleccionado, para duplicarlo basta con pulsar May+D. Con esto se 
creará una copia exacta, situada exactamente en la misma posición. Para llevar el nuevo objeto 
a una posición diferente, basta desplazar el ratón y, una vez alcanzada la ubicación deseada, 
hacer BIR. 

 
Una segunda opción es crear un duplicado enlazado. En este caso crearemos un segundo 
objeto que conservará siempre las propiedades del primero. Esto es, si cambiamos cualquier 
propiedad del primer objeto, los cambios tambien afectarán al segundo, si se hacen en el modo 
de edición. Para crear un duplicado enlazado se usa Alt+D. 
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Operaciones booleanas 
Una manera de operar con mallas es usar operaciones booleanas. 

Para comenzar una operación booleana debes selecionar los dos objetos a operar y pulsar W. 

 
En el presente ejemplo vamos a construir un cenicero. Usamos un cubo deformado como 
cuerpo del cenicero. Le restaremos una esfera para construir el cuenco en que cae la ceniza, y 
después cuatro cilindros para hacer las piezas sobre las que dejar un cigarro. Se deja al 
estudiante la construcción de los objetos. 
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Colocaremos la esfera sobre el cubo, de la forma que vemos a la derecha. Seleccionamos 
ambos objetos (primero el cubo y después la esfera, puesto que queremos coger cubo y 
restarle la esfera), pulsamos W y seleccionamos la diferencia de los dos objetos. 

  
Con esto crearemos un objeto como el que se ve a continuación. Sólo falta restarle cuatro 
veces el cilindro para construir el cenicero. 

 
Una vez visto el resultado de la sustracción, faltaría ver las otras dos operaciones booleanas. 

Con la intersección de dos objetos el resultados será el espacio en que coincidan ambos: 

 
El resultado de la unión de dos objetos se deja al estudiante. 
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En modo edición, al pulsar la tecla W se activa el menú Specials, que nos permite realizar la 
siguiente serie de acciones: 

 
• Subdivide divide cada una de las caras seleccionadas 

• Subdivide fractal también divide cada una de las caras, pero desplaza al azar cada 
uno de los nuevos vértices creados, con un grado de aleatoriedad seleccionado por el 
usuario. 

 
• Merge une todos los puntos seleccionados en uno solo, que se puede situar en el 

centro de los puntos seleccionados o bien en el punto en que se encuentre el cursor. 

 
• Remove Doubles intenta eliminar los vértices duplicados de entre los seleccionados. 

Para ello calcula las distancias entre vértices, y elimina aquellos que se encuentran a 
menos de 0.0001 unidades entre sí. 

• Hide oculta los vértices seleccionados. Con Reveal se vuelven a mostrar todos los 
vértices ocultados anteriormente. 

• Select swap invierte la selección: los vértices seleccionados pasan a no estarlo, y 
viceversa. 

• Flip Normals invierte las normales de cada una de las aristas seleccionadas (no tiene 
un efecto obvio). 

• Smooth intenta suavizar la malla, desplazando ligeramente cada vértice hacia el 
baricentro de los vértices seleccionados (en el caso de la esfera que ilustra esta 
página, el único efecto aparente sería la disminución de tamaño de la icosfera). 

• Bevel es el último método para añadir vértices y suavizar una malla. Nos pide un nivel 
de recursividad y permite controlar la disposición de los vértices añadidos arrastrando 
el ratón. 
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Tracking 
Con frecuencia nos interesará que un objeto apunte continuamente a otro, y no tener que 
actualizar la dirección en que mira cada vez que movemos el segundo objeto. En particular, es 
interesante que la cámara apunte al objeto principal de la escena, sin necesidad de irla girando. 
Esto se consigue con el 'tracking'. 

f 

Para conseguirlo seleccionaremos primero el objeto que tiene que tiene que apuntar al otro, y 
después el que tiene que seguirse y pulsaremos Ctrl+T. Para romper el seguimiento se pulsa 
Alt+T. 

Puede especificarse los ejes en que se hace el seguimiento desde el cuadro Anim Settings 
del panel Object. 

 

Texto 
Otro recurso para añadir objetos a una escena es el uso de texto (Espacio > Add > Text). 
Podemos sustituir el texto por defecto de Blender por el que deseemos. 

En el panel de edición aparecerá un cuadro Font desde el que podremos controlar diversos 
aspectos del texto, como son la alineación (Left, Middle, Right y Flush), el tamaño (Size), el 
espaciado (Spacing), la inclinación (Shear), el interlineado (Linedist), y la posición (X offset y 
Y offset). 

 
Además, pueden seleccionarse tipos de letra diferentes mediante el botón Load. Blender 
puede utilizar fuentes PostScript Type 1 y True Type (como las que utiliza Windows). 

Como con el resto de curvas y superficies, es conveniente usar la extrusión para dar volumen 
al texto creado. 
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Finalmente, para obtener un mayor control sobre el texto, puede convertirse el texto en curvas 
de tipo Bézier mediante (ALT+C). Una vez convertido el texto a una curva ya no podremos 
editarlo desde el teclado. 

 



Más operaciones con objetos 
En este tutorial veremos 4 nuevas operaciones para la creación o mejorado de objetos. 

Comenzaremos viendo la edición proporcional, que nos permitirá editar mallas complejas de 
manera más suave y natural. 

A continuación veremos el suavizado, que nos permitirá dar un aspecto más suave y natural, y 
menos 'informático' a los objetos creados previamente, aunque estos no presenten una gran 
complejidad en el diseño original. 

A continuación aprenderemos a crear objetos a partir de curvas y superficies de Bezier, 
haciendo uso de la extrusión. 

Finalmente, aprenderemos a crear sólidos de revolución a partir de curvas. 

Edición proporcional 

 
Si trabajamos con una malla compleja, como la de la figura (obtenida a partir de un plano y 
unas cuantas subdivisiones fractales), resulta complicado hacer alteraciones en la posición, 
escala o rotación de un grupo de puntos sin alterar de manera muy brusca la posición de las 
caras adyacentes. 

Para suavizar este efecto, se pulsa la tecla O, con lo que en la cabecera de la ventana aparece 
el icono: 

 
que indica que se ha entrado en modo proporcional. Ahora, al desplazar un punto o grupo de 
puntos, este desplazamiento afectará levemente a los vértices colindantes, con lo que se 
suaviza el efecto producido. 

Puede elegirse entre un efecto más suave (Smooth Falloff) o más brusco (Sharp Falloff), 
pulsando May+O o usando el menú. 

El radio de influencia del suavizado puede incrementarse o decrementarse pulsando + y - en el 
teclado numérico o con la rueda central del ratón. 

 

Suavizado 
Al crear objetos en Blender, el aspecto por defecto es 'de gráfico por ordenador': una serie de 
caras planas y aristas marcadas. Esto puede minimizarse activando las capacidades de 
suavizado. 
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Para ello accedemos al panel de edición y, en el cuadro Link and Materials, hacemos clic en el 
botón Set Smooth. Podemos volver al estilo original con el botón Set Solid. 

 
Es posible seleccionar qué caras queremos que aparezcan en cada uno de los dos estilos 
utilizando los botones desde el modo edición, seleccionando previamente las caras que 
deseamos que aparezcan con cada estilo. 

Una segunda opción es utilizar el botón Auto Smooth del cuadro Mesh. Con esta opción 
seleccionada, Blender calcula los ángulos entre caras contiguas y, si el ángulo es 
suficientemente bajo, aplica el suavizado automáticamente. El ángulo a partir del cual se aplica 
el suavizado puede controlarse mediante el botón Degr. El suavizado automático se aplica a 
aquellas caras a las que se les ha hecho un Set Smooth con anterioridad. 

 

Curvas y superficies 
Vamos a comenzar a trabajar con curvas de Bézier. Estas son curvas que permiten una gran 
flexibilidad en el diseño. 

En primer lugar, añadiremos una curva, pulsando espacio, y seleccionando Add > Curve > 
Bezier Curve. En la escena nos aparece una una curva con seis puntos, distribuidos en dos 
segmentos de color rosa. 

 
El punto central del segmento determina el extremo corresponiente de la curva, mientras que 
los otros dos determinan su curvatura. Es conveniente 'jugar' con todos los controles hasta 
adquirir cierta soltura en su manejo. 

A parte de desplazarse los seis puntos de control, pueden realizarse las siguientes acciones: 

• Con Ctrl+BIR añadimos un nuevo punto a la curva, a partir del extremo que tengamos 
seleccionado. 

• Si seleccionamos dos puntos consecutivos, podemos añadir un punto intermedio con 
W > Subdivide. 

• Se puede eliminar el punto seleccionado con X (o Supr) > Selected. 
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• En caso que deseemos que la unión de dos curvas sea brusca, y no suave, 
seleccionaremos el punto deseado y pulsaremos V. 

• Para cerrar la curva pulsaremos C. 

Utilizando este procedimiento puede dibujarse una figura como la siguiente: 

 
Si pasamos al modo de objetos y pulsamos Z podremos ver que hemos definido una superficie. 
Otra posibilidad de la que disponemos es la de crear agujeros en la nueva superficie. Para ello 
crearemos una circunferencia de Bezier dentro de la figura del corazón. Para ello, 
seleccionamos Add > Curve > Bezier Circle. 

Las circunferencias de Bezier se modelan de la misma forma que las curvas. 

 
Para tener un objeto utilizable, nos falta darle volumen al conjunto. Para ello haremos una 
extrusión. Para ello, tenemos que ir al panel de edición (F9). 

 
Los controles que nos interesan son: 

• Width determina el grosor de la extrusión. No es conveniente usar valores altos. Lo 
dejaremos al valor por defecto, 1. 

• Ext1 determina la altura que ganará el objeto. Podemos usar un valor de 0.4. 

• Ext2 determina el tamaño del biselado. Usaremos un valor de 0.09. 

• Finalmente, BevResol determina la resolución del biselado. Le daremos el valor de 1. 



Graduado en Multimedia (UOC)  Introducción a Blender 

Página  27

Creación de sólidos de revolución 
Vamos a crear una copa utilizando la técnica de rotar una curva alrededor de un eje. 

En primer lugar, en modo edición dibujamos el perfil de la copa (basta ir añadiendo puntos y las 
correspondientes aristas). Como si de su equivalente en la vida real se tratara, es conveniente 
que el vidrio tenga un cierto grosor. 

 
En el panel de edición tenemos el cuadro Mesh Tools (o herramientas para mallas), en el que 
tenemos el botón Spin, que nos permitirá rotar el perfil de la copa 360 grados para construirla. 

 
El botón Degr especifica los grados que rotaremos el objeto (y por tanto debemos disponerlo a 
360 grados), mientras que Steps decide cuántas paradas se harán en la rotación (es 
conveniente experimentar para ver qué valores son más adecuados. 

La rotación se producirá alrededor del cursor, y el eje quedará determinado por la vista en que 
nos encontremos. Por tanto, deberemos colocarnos en una vista superior, colocar el cursor en 
el centro de la copa y hacer clic en Spin. En caso de que tengamos más de una vista 
tridimensional en pantalla, tendremos que seleccionar cuál determina la rotación. 

Es aconsejable eliminar los puntos duplicados que habremos creado, desde el menú Specials 
(tecla W). 

 
Una herramienta emparentada con Spin nos permite hacer duplicados de un objeto y 
repartirlos automáticamente a lo largo de una circunferencia. Vamos a hacer 8 copias de 
nuestra copa y disponerlas en círculo. 

Para ello, primero colocaremos la copa alejada del centro de una hipotética mesa 
(aprovecharemos para escalarla al tamaño adecuado). 
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Nos ponemos en modo edición, seleccionamos todos los puntos de la copa, colocamos en el 
botón Degr los 360 grados que queremos que giren nuestras copas en la mesa, selecionamos 
8 en Steps, usamos una vista superior, colocamos el cursor en el 'centro de la mesa' y 
hacemos clic en el botón 'Spin Dup'. 

De la misma forma que con Spin habíamos creado vértices de más, ahora hemos duplicado 
una copa. Para eliminarla, basta con pulsar Supr (o la tecla X) y seleccionar Vertices en el 
menú que aparecerá. 

  

Screw 
Screw (atornillado) es una variación de los sólidos de revolución que añade un desplazamiento 
vertical durante la rotación. Se parte siempre de la vista frontal y una curva poligonal como la 
que se aprecia en la imagen.  

Debe colocarse el cursor en el eje alrededor del cual quiere hacerse girar la curva, y en el 
panel Mesh Tools (del panel de edición) seleccionamos en Steps la cantidad de pasos a dar y 
en Turns el número de giros antes de hacer clic en Extrude. 
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Seleccionando 10 pasos y 4 giros se obtiene, a partir de la curva ejemplo, el resultado de la 
derecha. 

  



Un primer ejercicio de modelado 
En este ejercicio utilizaremos muchos de los conocimientos adquiridos hasta ahora. En muchas 
ocasiones será conveniente retroceder a los tutoriales anteriores y recuperar la información que 
allí había. Esto es muy conveniente, ya que hemos llegado a un punto en el que podemos 
trabajar con el software con más soltura, pero hay habilidades que no tenemos automatizadas. 

También usaremos algunas técnicas que no se han descrito hasta ahora, y que podremos ver 
en más profundidad en el futuro. Pero una vez adquiridos unos mínimos, es hora de construir 
algo ya. 

Finalmente, anotar que este tutorial es una adaptación de la primera actividad guíada que 
forma parte del proyecto de documentación de Blender. Dicho proyecto, en inglés, está 
disponible en la web www.blender.org. 

En primer lugar, a partir del cubo que coloca Blender por defecto en el escenario, crearemos 
este medio esqueleto. 

 
Recordemos algunos detalles importantes para crearlo: 

• Para entrar en el modo de edición de objetos, si no estamos ya en él, usamos TAB. 

• Seleccionamos y deseleccionamos todos los puntos del objeto pulsando A. 

• Podemos seleccionar puntos usando el pincel con B. 

• Realizamos extrusiones con la tecla E. Podemos bloquear la dirección en que se 
realiza la extrusión pulsando BCR. 

Repetimos los pasos realizados hasta obtener un esqueleto completo. 
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Desplazamos el punto de vista para apreciar el cuerpo construido. Deseamos un cuerpo 
'aplastado'. Para conseguirlo, en modo de objeto escalamos (S), restringiendo la acción al eje Z 
(basta pulsar Z después de S). Reescalaremos hasta que el cuerpo tenga aproximadamente un 
tercio del grosor original. 

 
Ahora sólo nos falta añadirle una cabeza al cuerpo. Para ello, usaremos un nuevo cubo. Como 
antes, necesitaremos 'achatar' la cabeza para que esté en proporción con el resto del cuerpo. 

  
Una vez hecho esto, queremos darle al muñeco un aspecto más suave. Para ello, vamos al 
panel de edición (se puede acceder a él pulsando F9) y activamos la subdivisión de superficies 
(botón Sub Surf), tanto para el cuerpo como para la cabeza. 

  
Si activamos la vista de cámara (KP0) podremos apreciar la vista actual. Vemos que no es la 
mejor posible para mostrar el modelado que hemos hecho hasta el momento. Volvemos a otra 
vista y desplazamos la cámara hasta conseguir un buen punto de vista. 
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Recordemos que, si durante el desplazamiento de un objeto pulsamos la tecla CTRL, el 
movimiento se ajustará a la rejilla, y el objeto seleccionado se moverá de unidad en unidad. 

Nos gustaría que, independientemente de la posición del muñeco, la cámara siempre le 
apuntara de manera automática. 

Para ello, con la cámara seleccionada, seleccionamos también el cuerpo del muñeco 
(May+BDR), pulsamos CTRL+T y seleccionamos Constraint. 

 
Aparecerá una línea azul uniendo la cámara con el muñeco. Podemos comprobar que funciona 
desplazando el muñeco y observando cómo le sigue la cámara (con cuidado de no separar 
cuerpo y cabeza). 

 
Una vez llegados a este punto convendría guardar el trabajo realizado. Para ello, utilizamos el 
menú File > Save o bien la combinación de teclas Ctrl+W. Elegimos una ubicación y un 
nombre para el archivo y lo guardamos. Para abrirlo de nuevo basta con acceder a File > Open 
o pulsar F1. 

 
Al desplazar el muñeco hemos podido comprobar que, de le manera en que hemos seguido los 
pasos, la cabeza y el cuerpo son objetos diferentes. Para unirlos basta seleccionar ambos 
objetos, pulsar ESPACIO y elegir la opción Object > Join Objects... Alternativemente, 
podemos utilizar el atajo de teclado Ctrl+J. 
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El siguiente paso será construir un suelo en el que apoyar el muñeco. Bastará añadir una malla 
poligonal del tipo plano, y escalarla, rotarla y trasladarla hasta un lugar correcto. 

Es muy importante estar en modo objeto al añadir el suelo. De otra forma, el suelo y el muñeco 
quedarían unidos y después no podríamos desplazar de manera sencilla el muñeco 
independientemente. 

Un último paso será colocar la lámpara en un lugar adecuado para iluminar el muñeco, y 
seleccionar un tipo de lámpara adecuado. Para ello, primero colocaremos la lámpara (Lamp) 
que Blender coloca por defecto en la escena ligeramente por detrás de la cámara. 

 
Para seleccionar las propiedades de la lámpara seleccionamos el panel de sobreado (F5) y los 
botones de lámpara. 

 

 
En el panel Preview seleccionaremos como tipo de lámpara Spot (Foco). En el panel Lamp, 
ajustaremos los colores (R, G y B) a 1, 1, 0.9, de manera que la luz sea de color amarillo 
pálido. 

Hacemos que la lámpara apunte al muñeco (seleccionamos la lámpara y el muñeco en este 
orden, pulsamos Ctrl+T). 

En el panel Shadow and Spot, Clip Sta y Clip End controlan los puntos entre los que los 
objetos generan sombra. Debemos asegurarnos de ajustar Clip End para que esté por detrás 
de nuestro muñeco y del suelo. Ajustamos Samples a 4 y Soft a 8. 
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Aparte del foco que acabamos de crear añadiremos una segunda lámpara, junto a la primera, 
del tipo Hemi, con energía (Energy) 0.6, de forma que apunte hacia el muñeco, para suavizar 
la escena. 

Una vez que estemos satisfechos con la escena, pulsaremos F12 para generar una imagen 
final. Después de realizar todos los cambios necesarios para obtener una imagen a nuestro 
gusto, guardaremos la imagen generada con File > Save Image... o con F3. 

Vamos a darle un material a la superficie del muñeco. Para ello lo seleccionamos y vamos al 
panel de sombreado y a la botonera de materiales. 

 
A continuación, damos los valores que se aprecian en la figura (R 0.429, G 0.218, B 0.134, 
Hard 5, Ref 0.8, Spec 0.05). En primer lugar, le asignamos el nombre MaterialMuñeco al 
material, tecleando en el lugar en que por defecto se lee MA:Material. 

 
En la botonera de texturas ponemos como nombre de textura TexturaMuñeco, seleccionamos 
el tipo de textura Stucci, con los parámetros 0.02 para NoiseSize y 5 para Turbulence. 

 
Volvemos a los botones de materiales y, en la última botonera, nos vamos a la pestaña Map 
To, en la que seleccionamos los valores indicados en la figura: 

 
Saltamos de nuevo a la pestaña Texture y añadimos una segunda textura, que llamaremos 
Grano. 
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Haremos que esta segunda textura sólo afecte a la propiedad Ref (es decir, a la reflectividad 
del material) con valor de 0.4 en Var (que decide el efecto que tendrá la textura al combinarse 
con otras). 

  
Finalmente, añadimos un material de color azul para el suelo. Basta seleccionar la malla 
poligonal que hemos usado como suelo y añadir un nuevo material, que llamaremos suelo, y 
darle las propiedades que estimemos convenientes. 

Pasamos ahora a añadirle unos ojos a la cara del muñeco. Los añadiremos como UVesferas, y 
nos aseguraremos de hacerlo en modo objeto. De esta manera, los ojos serán objetos 
diferentes y les podremos asignar características diferentes. Como se trata de objetos muy 
pequeños, podemos reducir la cantidad de segmentos y anillos a 16. 

Usaremos los conocimientos adquiridos para colocarlos en el lugar adecuado de la cara, con el 
tamaño correspondiente. 

Para hacer la boca, utilizaremos lo aprendido con Spin para llegar al siguiente resultado. Basta 
con colocar una primera bola en la posición marcada por la bola rosa, centrar el cursor en la 
cara, y hacer un SpinDup de 90 grados en tres pasos, como se muestra en la imagen. De 
manera similar, le añadiremos tres botones al cuerpo. 

   
Daremos a los ojos un material de color marrón, a la boca blanco, y los botones serán de color 
rojo, blanco y verde. Colocamos la cámara en un lugar adecuado, hacemos cualquier último 
ajuste a luces, materiales, posiciones... y pulsamos F12 para hacer el render definitivo. 

Es el momento adecuado de guardar tanto el modelo (Ctrl+W) como la imagen (F3). Antes de 
guardar, debemos decidir el formato de imagen mediante los botones de Render del panel de 
Escena (F10). 

 




